Roofs

Roofs come in all shapes and sizes. Given the nature of roofs, there is a lot to think about when you place a roof onto your building. If it’s a flat roof, pitch is definitely a consideration. Drainage to roof drains or scuppers is another concern. But how about pitched roofs? Now you’re in an entirely new realm of options, pitches, slopes, and everything else you can throw at a roof design. Also, there are always dormers that no pitched roof can live without! Do the dormers align with the eaves, or are they set back from the building?

This chapter covers the following topics:

- Placing roofs by footprint
- Creating a sloping roof
- Creating roofs by extrusion
- Adding a roof dormer

Placing Roofs by Footprint

This book can’t address every situation you’ll encounter with a roof system, but it will expose you to the tools needed to tackle these situations yourself. The techniques you’ll employ in this chapter start with the concept of adding a roof to the model by using the actual floor-plan footprint. As with floors, you’ll also build the roof’s composition for use in schedules, quantities, and material takeoffs.

The command you’ll probably use most often when working with roofs is the one to place a roof by footprint. Essentially, you’ll create a roof by using the outline of the building in the plan view. There are three roof types you’ll place by using a footprint.

- A flat roof (OK, no roof is actually flat, but you get the point)
- A gable roof, which has two sides that are sloped and ends that are left open
- A hip roof, which has all sides sloped
You have only these options while placing a roof by footprint because you’re looking at the roof in the plan, which limits your ability to place a roof with nonuniform geometry. Later in the book, you’ll explore doing just that, but for now let’s start with placing a flat roof by using the footprint of the east wing.

**Flat Roofs by Footprint**

To begin, open the file you’ve been using to follow along. If you didn’t complete Chapter 6, “Floors,” go to the book’s web page at [www.sybex.com/go/revit2017ner](http://www.sybex.com/go/revit2017ner). From there, you can browse to Chapter 7 and find the file called NER-7.rvt.

**NOTE** Metric users should not type in mm or other metric abbreviations when entering amounts suggested in the exercises. The Autodesk® Revit® Architecture platform won’t accept such abbreviations. Simply enter the number provided within the parentheses.

The objective of this procedure is to create a flat roof by outlining the building’s geometry in the plan. Follow these steps:

1. In the Project Browser, double-click the Roof view in the Floor Plans section (be careful not to click Roof in the Ceiling Plans).
2. Zoom into the east wing.
3. In the view Properties, find the Underlay row, and select None from the menu, as shown in Figure 7.1.
4. Click the Apply button if it’s not already active.
5. Select all of the CMU walls.
6. Set Top to Up To Level: Roof.
7. Set Top Offset to -1’-0” (-300 mm).
8. On the Architecture tab, click Roof ➔ Roof By Footprint, as shown in Figure 7.2.
9. On the Modify | Create Roof Footprint tab, be sure the Pick Walls button on the Draw panel is selected, as shown at the right in Figure 7.3.
10. On the Options bar, deselect Defines Slope.
11. On the Options bar, make sure Overhang is set to 0’-0” (0 mm).
12. Deselect Extend Into Wall Core (if it’s selected).
13. Hover your pointer over the leftmost vertical wall. When it becomes highlighted, press the Tab key on your keyboard. All the perimeter walls highlight (see Figure 7.3). When they do, pick (left-click) anywhere along the wall. This places a magenta sketch line at the perimeter of the building.

15. Go to a 3D view, as shown in Figure 7.4.
With the roof added, step 1 is out of the way. Now you need to create a roof system. You’ll do this the same way you created your floor system in Chapter 6.

Creating a Flat Roof System

Although you can use this system for a pitched roof, the steps for a flat roof system differ slightly. In Revit Architecture, there are two ways to look at a roofing system. One way is to create it by using all the typical roof materials and a large space for the structural framing. In this book, I don’t recommend that approach. Creating a roof by using only the roofing components is necessary, but adding the structure will lead to conflicts when the actual structural model is linked with the architectural model. Also, it’s hard for the architect to guess what the depth of the structural framing will be. In Revit, you want each component to be as literal and as true to the model as possible. The second way to look at a roofing system, as you’re about to explore, is to build the roof in a literal sense—that is, to create the roof as it would sit on the structural framing by the structural engineer.

The objective of this procedure is to create a roof system by adding layers of materials. Follow these steps:

1. Select the roof. (If you’re having trouble selecting the roof, remember the Filter tool.)
2. In the Properties dialog box, click Edit Type.
3. Click Duplicate.
4. Call the new roof system 4” Insulated Concrete Roof (100 mm Insulated Concrete Roof).
5. Click OK.
6. Click the Edit button in the Structure row.
7. Change the material of Structure 1 to Concrete, Lightweight. (You do this by clicking in the cell and then clicking the […] button. You can then select the material from the menu.) After the material is selected, click OK.
8. Change the structure Thickness to 4” (100 mm), as shown in Figure 7.5.
9. Insert a new layer above the core boundary. (You do this by clicking the number on the left side of the Layers Above Wrap row and clicking the Insert button below the Layers section, as shown in Figure 7.5.)
10. Change the function of the new layer to Thermal/Air Layer [3].
11. Click in the Material cell.
12. Click the […] button to open the Material Browser.
13. Select Rigid Insulation for the material.
14. Click OK.
15. Change Thickness to 4” (100 mm).
16. Click the Variable button. When you modify the roof, this insulation layer will warp, enabling you to specify roof drain locations.
17. Insert a new layer above Insulation.
18. Give it a Function of Finish 1 [4].

20. Click OK.

21. Change Thickness to 1/4” (6 mm), as shown in Figure 7.6.

22. Click OK.

23. Click OK again to get back to the model.

24. Press Esc or click in open space to clear the roof selection.

Phew! That was a long procedure. It was worth it, though. You’ll be using this process a lot in Revit Architecture.

For the next procedure, you’ll add some roof drain locations and then taper the insulation to drain to those locations.
Take a Look

It’s always a good idea to keep the preview window open when you modify the roof system. If you look toward the bottom of the Edit Assembly dialog box, you’ll see a Preview button, as shown here. Click it, and you can see the roof as it’s being constructed.

Tapering a Flat Roof and Adding Drains

If you went through the floor procedure in Chapter 6, you’ll see that the process for tapering a roof is similar to pitching a floor. You may have also noticed that creating a roof system is identical to creating a floor system.

To taper the roof insulation, you must first divide the roof into peaks and valleys and then specify the drain locations based on the centering of these locations. Follow these steps:

1. In the Project Browser, make sure you’re in the Roof floor plan.
2. Select the roof. (You may have to use the Filter tool.)

Tip

Even when you do successfully select the roof, you may not be able to tell. The roof doesn’t seem to highlight. When the roof is selected, the Options bar shows the Modify icons. Also, look in the top of the Properties dialog box—it should read Basic Roof: 4” Insulated Concrete Roof.
3. Click the Add Split Line button, as shown in Figure 7.7.

![Figure 7.7: Start splitting the radial portion of the roof.]

4. Draw lines from the points shown in Figure 7.7.

5. Press Esc twice.

6. Select the roof.

**Tip** The Chain tool is nice, but make sure it’s deselected if you only want to draw single items.

**Tip** One really nice thing about modifying the roof is that now, to select the roof, all you need to do is pick one of the ridgelines.

7. Click the Add Point button, as shown in Figure 7.8.

8. Add two points at the midpoints marked 1 and 2 in Figure 7.8.

9. Click the Add Split Line button, and draw a ridge across the entire length of the building from point 1 to point 2, as shown in Figure 7.9.

10. Press Esc twice, or click Modify. Then, on the Architecture tab, click Ref Plane, as shown at the upper right in Figure 7.10.
11. Draw four reference planes spaced approximately the same as in Figure 7.10.

12. On the Annotate tab, click the Aligned Dimension button.

13. Add a dimension string starting at the exterior wall to the left and ending at the exterior wall to the right (see Figure 7.10).

14. Click the blue EQ icon. This equally constrains the reference planes.

15. Press Esc twice, or click Modify to terminate the command.
16. Select the roof.

17. Click Add Split Line, as shown in Figure 7.11. Be sure to clear the Chain option.

**Figure 7.10**: Add a dimension string to the reference planes shown here.

**Figure 7.11**: The ridges are in. All that is left is to create some points and start tapering the roof.
18. Draw four ridges at the intersections of the reference planes (see Figure 7.11).

19. Press Esc.


21. On the Annotate tab, click the Detail Line button.

22. Draw a diagonal line between the two points shown in Figure 7.12.

23. Click Modify, and then select the roof.

24. Click the Add Point button.

25. Pick the midpoint of the diagonal line.

26. There is a node where you picked the point. To access the node, click the Modify Sub Elements button on the Shape Editing panel, as shown in Figure 7.13.
27. Pick the point you just added. A blue elevation appears, as shown in Figure 7.14. Click the elevation, and type -3” (-75 mm).

28. Press Esc twice.

This process tapers the insulation only in this bay, as shown in Figure 7.15. The objective now is to do the same thing for every bay. Because you can't copy a point, you need to move the temporary line to the next bay and add a new point.
Follow along to create another taper:

1. Move the diagonal line (which you drew as a reference) to the next bay to the right.
2. Select the roof.
3. Click the Add Point button.
4. Click the Modify Sub Elements button, and add a point to the midpoint of the line.
5. Type -3" (-75 mm) in the blue elevation. The roof tapers.
6. Move the line to the next bay, and repeat the process.

**NOTE** As you’re adding additional lines in this section, remember that I’m merely recommending that you use the Move tool. At this point, you have enough experience either to draw in the lines or to use any tool you’ve studied thus far.

7. Complete every bay.
8. Add points to the radial area as well.
9. Delete the dimensions, the reference lines, and the detail lines.
11. Your roof should look like Figure 7.16 when you’ve finished.
To further investigate how this roof works and to illustrate the benefits of using this approach rather than drafting the lines, let’s cut a section through the roof and see how the detail looks.

1. On the Create panel of the View tab, click the Section button.

2. Add a section through the roof, as shown in Figure 7.17.
3. In the Type Selector, make sure the type of section is a building section, and change View Scale to $3/4'' = 1'-0''$ (1:20 mm).

4. Change Detail Level to Fine.

5. Change the View Name option (under Identity Data) to Roof Taper Section (see Figure 7.18).

![Figure 7.18: Changing the properties of the section](image)

6. Click the Apply button.

7. Double-click the section head (or find the section called Roof Taper Section in the Project Browser).

8. Adjust the crop region so you’re looking only at the roof area, as shown in Figure 7.19. Zoom to fit.
This concludes modeling a flat roof. You can now move on to creating a pitched roof. Again, although these types of roofs can be easy to add in the beginning, more work will be required to get them exactly the way you want them.

**The Proof Is in the Roof!**

This is a perfect example of why the Revit approach to design documentation is the way to go. Although the sloping of the slab may have seemed tedious, in reality it didn’t take much longer than it would have if you had drafted those lines in a CAD application. But now, to produce a section, all you need to do is to cut one. Also, if you change the location or the depth of the roof pitch, your lines in the plan will be accurate, as will your section.

**Pitched Roofs by Footprint**

You’ll add a pitched roof in a manner identical to the way you added the flat roof. The only real difference is that each magenta sketch line will need more attention before you finish the sketch. But after tapering the roof’s insulation, this will be a cakewalk.

You’ll place the pitched roof over the corridor. The problem with the corridor is that you used a wall system with a parapet cap. This isn’t the best wall system to receive a pitched roof. First, you’ll change to a simpler wall system, as follows:

1. Go to a 3D view of the model.
2. Select the six corridor walls, as shown in Figure 7.20.
3. In the Properties dialog box, click the Edit Type button.
4. Click the Duplicate button.
5. Call the new wall system Exterior – Brick and CMU on MTL. Stud (No Parapet).
6. In the Structure row, click the Edit button.

7. In the Edit Assembly dialog box, make sure the Preview button is selected and the view is set to Section, as shown at the bottom of Figure 7.21.

**Figure 7.20**: Select the six walls to be modified.

**Figure 7.21**: Without the Preview button selected and set to Section, you can't modify the parapet sweep.
8. Click the Sweeps button (see Figure 7.21).

9. In the Wall Sweeps dialog box, you see three sweeps. The top sweep is the parapet cap. Select sweep 1 (Parapet Cap), and click the Delete button, as shown in Figure 7.22.

![Wall Sweeps dialog box](image)

**Figure 7.22:** Deleting the Parapet Cap sweep

10. Click OK three times.

Your corridor walls should look the same, but they’re now void of the concrete parapet cap.

**NOTE** Although you have pretty good experience with walls up to this point, Chapter 15, “Advanced Wall Topics,” is dedicated to the advanced concepts and creation of wall systems.

It’s time to add the roof to the corridor. Because the walls your roof will bear on are now correct, the rest will be a snap! Here are the steps:

1. Go to the Level 3 floor plan. (This is the roof level for your corridor.)
2. On the Architecture tab, choose Roof ➤ Roof By Footprint.
3. On the Draw panel, make sure the Pick Walls button is selected.
4. On the Options bar, make sure the Defines Slope button is selected.
5. Type 1’ (300 mm) in the Overhang field.
6. Pick the six walls that compose the corridor, as shown in Figure 7.23.

**Figure 7.23:** Pick these walls for the roof’s footprint.

With the easy walls out of the way, let’s create the gable ends. You should still be in Pick Walls Mode. This is OK, but there are a few things you need to change on the Options bar.

1. Click the Boundary Line button on the Draw panel if it isn’t still active.
2. On the Draw panel again, click the Pick Lines icon, as shown in Figure 7.24.
3. On the Options bar, deselect Defines Slope.
4. For the offset, enter 0.
5. Pick the east wall of the west wing and the west wall of the east wing (see Figure 7.24).
It’s cleanup time! Of course, the magenta lines are overlapping at the long walls. This is OK—you’re an expert at the Trim command by now, especially in Sketch Mode:

1. On the Modify | Create Roof Footprint tab, select the Trim/Extend To Corner command.

2. Trim the intersections that overlap. There are four of them (see Figure 7.25).

3. On the Mode panel, click Finish Edit Mode, and go to a 3D view.
One ugly roof, huh? Welcome to the world of pitched roofs in Revit. You'll get the roof you want—you just need to add two roofs here. You'll understand this process, but it's going to involve patience and trial and error!

To fix this roof, you simply have to make two separate roofs and join them. This is a common procedure for the more complicated roof systems in Revit. Here are the steps:

1. If you aren't in Level 3, go there now, and select the roof.

2. On the Modify | Roofs tab, click the Edit Footprint button, as shown in Figure 7.26.

3. Delete every line other than the three shown in Figure 7.27.

4. On the Draw panel, click the Line button.

5. Draw a diagonal line between the endpoints of the two lines, as shown in Figure 7.28. Make sure the Defines Slope button isn't selected.

6. On the Modify | Roofs ➤ Edit Footprint tab, click Finish Edit Mode. The roof displays. It still looks funny, but you'll take care of that soon by altering the view range to make the view deep enough to display the ridge of the new roof.
**Figure 7.27**: Keep these three lines.

**Figure 7.28**: Draw a diagonal line as shown.
7. Start the Roof ➔ Roof By Footprint command again on the Architecture tab. You can also select the roof and click Create Similar on the Modify | Roofs tab that is currently active.

8. On your own, sketch the roof shown in Figure 7.29. Make sure the lines along the walls are defining a slope. The lines that represent the ends of the roof don't slope.

9. To add the line that matches the roof to the right, make sure the Boundary Line button is selected on the Draw panel and that Pick Lines is selected as well. Now simply pick the roof to the right, and the line appears.

10. Review Figure 7.29 to see whether your sketch matches. You should have six lines total, and the right and the left ends should not have a slope.
11. On the Modify | Create Roof Footprint tab, click Finish Edit Mode.

12. Go to a 3D view. Does your roof look like Figure 7.30?

If you accidentally add a line with (or without) a slope, that’s fine. You can change it. First, press Esc (to clear the command), and then select the line that needs to be changed. On the Options bar, you can select (or deselect) Defines Slope.

The walls need some help! They’re indiscriminately poking up through the roof. Let’s do some wall cleanup. First, you need to force the walls to use a mitered join at the 45° intersections. The following procedure shows you how:

1. Go to the Level 1 floor plan.

2. Zoom into the wall intersection, as shown in Figure 7.31.

3. On the Modify tab, click the Wall Joins button (see Figure 7.31).
4. Move your cursor over the intersection. A box forms around the corner. When you see this box, pick the wall.

5. On the Options bar, click the Miter radio button. The walls are now joined at a miter.

6. Perform this procedure at all four corners.

You can now attach the tops of the walls to the bottom of the roof, as follows:

1. Go back to a 3D view, and select one of the corridor walls.

2. On the Modify | Walls tab is an option to attach the top or base of the wall, as shown in Figure 7.32. Click the Attach Top/Base button.

3. Pick the roof that the wall is under. The wall no longer sticks up past the roof.

4. Perform steps 1 through 3 for each corridor wall. When you've finished, your corridor roof should be magnificent, just like Figure 7.33.

---

**Figure 7.31:** Modifying the walls’ corners
FIGURE 7.32: Attaching the top or the base

FIGURE 7.33 The completed corridor roof
But I Got This Warning!

Sometimes Revit doesn’t like you hacking up its perfectly fine walls. The warning shown in this image pertains to the soldier course in the wall. Because the walls are now lower than that elevation, Revit is kind enough to tell you.

Viewing a Sloped Roof in the Plan

Back in Level 3 (the level in which the corridor roof resides), you’re having a view problem: the roof is showing up only to the cut plane for that level. This can’t be. There is a procedure to correct this, called a plan region. Here are the steps:

1. Go to the Level 3 floor plan.
2. On the View tab, choose Plan Views ➢ Plan Region, as shown in Figure 7.34.

Figure 7.34: Using a plan region enables you to alter the view range in a specified area of a plan.
3. On the Draw panel, click the Rectangle button, as shown in Figure 7.35.

![Figure 7.35: Creating the rectangle that forms the perimeter of the plan region](image)

4. Draw a rectangle around the corridor (see Figure 7.35). Be sure to snap to the exact points where the roof meets the taller walls on the east and west wings.

5. In the Properties dialog box, click the Edit button in the View Range row (see Figure 7.36).

![Figure 7.36: Setting the View Range for the plan region](image)
6. In the View Range dialog box, set Top to Unlimited and Level 3 Cut Plane Offset to 35’-0” (11500 mm), as shown in Figure 7.36.

7. Click OK.

8. On the Modify | Create Plan Region Boundary tab, click Finish Edit Mode.

You can now see the roof in its entirety, as shown in Figure 7.37.

There is one more kind of roof to add. It will be a flat roof that has a slope in a single direction. Although you can do this by simply creating a roof with one edge specified as a pitch, at times you’ll want a roof sloped at an odd direction that can’t be handled by angling a roof edge.

**Creating a Sloping Roof**

To begin the process of creating a sloping roof, you’ll cap off the west wing of your building. The exterior walls used for the perimeter need to be altered. You’re already a pro at this, so let’s start right there.

1. Go to a 3D view.

2. Select the west wing exterior walls (see Figure 7.38).
3. In the Type Selector, select Exterior – Brick And CMU On MTL. Stud (No Parapet), as shown in Figure 7.38.

4. In the Project Browser, go to the West Roof floor plan.

5. On the Architecture tab, choose Roof ➢ Roof By Footprint.

6. On the Draw panel, verify that the Pick Walls button is selected.

7. On the Options bar, deselect Defines Slope.

8. Type 1’ (300 mm) for the Overhang value.

9. Move your cursor over a wall. Make sure the overhang alignment line is facing outside the walls to the exterior.

10. Press the Tab key. All the walls are selected.

11. Pick the wall. The magenta lines are completely drawn in. Your sketch should look like Figure 7.39.
Now it’s time to set the slope. The objective here is to slope the roof starting at the northeast corner (as the low point) and ending at the southwest corner (the high point). You do this by adding a slope arrow, as follows:

1. On the Draw panel, click the Slope Arrow button, as shown in Figure 7.40.

2. Pick the corner at the upper right and then the corner at the lower left, as shown in Figure 7.41.

3. Press Esc.
4. Select the slope arrow you just added to the model.

5. In the Properties dialog box, under Constraints, change Specify to Slope.

6. Under Dimensions, change Slope to 3” / 12” (250 / 1000 mm), as shown in Figure 7.42.
7. Click Finish Edit Mode on the Modify | Create Roof Footprint tab.

Again, you have a view range issue. You can see only the corner of the roof that sits below the cut plane. You can change that with the view range:

1. Press Esc to display the view properties in the Properties dialog box.
2. Scroll down the list until you arrive at the View Range row. When you do, click the Edit button.
3. In the View Range dialog box, under Primary Range, set Top to Unlimited.
4. Set the Cut Plane Offset to 40’ 0” (12000 mm), as shown in Figure 7.43.

![Image of View Range dialog box]

**FIGURE 7.43:** Setting the view range

5. Change the rest of the settings to reflect Figure 7.43.
6. Click OK. You can see the entire roof.
7. Go to a 3D view. You now have a cool, sloping roof, as shown in Figure 7.44.
Of course, there is a wall issue. You can attach most of the walls to the roof simply by selecting them and attaching the tops. But you’ll have to modify the profile for one wall, as follows:

1. In the 3D view, select all of the exterior west wing walls, excluding the one on the east side that is west of the corridor. (You can see it in Figure 7.45.)
2. On the Modify | Walls tab, select Attach Top/Base.
3. Pick Top from the Options bar (it’s all the way to the left).
4. Pick the sloping roof (see Figure 7.45).
5. In the Project Browser, go to the section called West Corridor Section.
6. Select the wall that doesn’t attach to the roof.
7. On the Mode panel, click Edit Profile.
8. Trace the roof with the Line tool. Be sure you delete the magenta line that established the top of the wall.
9. On the Sketch tab, click Finish Edit Mode. All the walls are now joined to the roof. This would be a good time to check out the roof in 3D just to make sure the results are pleasing to you.
10. Save the model.

The next item to tackle will be creating a roof by extrusion. This is where you can design a custom roof.

**Creating Roofs by Extrusion**

Creating a roof by extrusion is almost always done in an elevation or a section view. The concept is to create unique geometry that can’t be accomplished by simply using a footprint in a plan. A barrel vault or an eyebrow dormer comes to mind, but there are literally thousands of combinations that will influence how your roofs will be designed.

To get started, the last roof left to be placed is the south jog in the west wing of the model. This is the perfect area for a funky roof!

The first thing to do is to change the three walls defining the jog to the Exterior – Brick And CMU On MTL. Stud (No Parapet) wall type.

1. Go to a 3D view.
2. Select the three walls that compose the jog in the south wall (see Figure 7.46).
3. From the Properties dialog box, switch these walls to Exterior – Brick And CMU On MTL. Stud (No Parapet), as shown in Figure 7.46.
4. Go to the Level 1 floor plan.
5. On the View tab, click the Elevation button.

6. In the Properties dialog box, be sure that the elevation is a Building elevation (you’re given the choice in the drop-down menu at the top of the dialog box).

7. Place the elevation as shown in Figure 7.47.

8. Open the elevation you just created.

9. Pick the view extents (the blue grips at the ends of the elevation), and drag them in so that you can see only the west wing.

10. Make sure you pull the view depth window back to see the wall beyond (see Figure 7.47).

11. Change View Scale to 1/2” = 1’0” (1:20 mm).

12. Change Detail Level to Fine.

13. Change View Name to South Entry Elev.

14. Click the Apply button.

---

**Figure 7.46:** Changing the wall types as you have been doing all along
15. On the Architecture tab, click the Ref Plane button; then, in the Draw panel, click the Pick Lines button.

16. Set Offset to 1'–6” (450 mm).

17. Pick the southernmost wall, and offset the reference plane away from the building (see Figure 7.48).
18. Press Esc twice, or click Modify to clear the command.
19. Select the reference plane.
20. In the Properties dialog box, change the name to South Entry Overhang.
21. Click Apply.
22. Open the elevation called South Entry Elevation.

The importance of the reference plane that you just added becomes obvious at this point. You needed to establish a clear starting point for the roof you're about to add. Because the roof will be added in an elevation, Revit doesn't know where to start the extrusion. This reference plane will serve as the starting point. Naming reference planes is the way you can use them when they aren't visible in the view. Continue with these steps:

1. On the Architecture tab, choose Roof ➤ Roof By Extrusion, as shown in Figure 7.49.

![Figure 7.49: The Roof ➤ Roof By Extrusion command](image)

2. When you start the command, Revit asks you to specify a reference plane. Select Reference Plane: South Entry Overhang from the Name drop-down list, as shown in Figure 7.50.

3. Click OK.

4. In the next dialog box, change the Level setting to Level 3, and click OK.
5. In the Work Plane panel, click Ref Plane, as shown in Figure 7.51, and then click the Pick Lines button.

6. Offset a reference plane 3’–0” (900 mm) to the left and to the right of the exterior walls, marked 1 and 2 in Figure 7.51.

7. Offset a reference plane 4’–0” (1200 mm) up from the top of the wall, marked 3 in Figure 7.51.
8. In the Properties dialog box, select Roofs from the drop-down list, and then click the Edit Type button.

9. Click Duplicate.

10. Change the name to Canopy Roof.

11. Click the Edit button in the Structure row.

12. In the Edit Assembly dialog box, change the structure thickness to 4” (100 mm), as shown in Figure 7.52.

13. Click OK twice to get back to the model.

It’s time to put the actual roof into the model. So far, you’ve been using great discipline in terms of setting reference planes and creating a separate roof for this canopy. Try to make this a habit! Follow these steps:

1. On the Draw panel of the Modify | Create Extrusion Roof Profile tab, click the Start-End-Radius Arc button, as shown in Figure 7.53.

2. Draw an arc from the points shown in Figure 7.53.
**TIP**  When you’re adding a roof by extrusion, you need to draw only one line. The thickness is defined in the roof you’re using. After you click Finish Edit Mode, the 4” (100 mm) thickness will be added to the bottom.

3. In the Properties dialog box, set Extrusion End to -2’–0” (-600 mm), as shown in Figure 7.54.

**FIGURE 7.53**: Drawing an arc, which will define the outside face of the roof

**FIGURE 7.54**: Setting Extrusion End
4. Click Finish Edit Mode.
5. Go to a 3D view. Your roof should look like Figure 7.55.

![The almost completed canopy roof](image)

**Figure 7.55:** The almost completed canopy roof

There is just one thing left to do, and it’s pretty obvious: you need to attach the roof to the wall. This can be done in one command.

1. On the Modify tab, click the Join/Unjoin Roof button, as shown in Figure 7.56.
2. Pick the top, back arc on the canopy roof, as shown in Figure 7.56.
3. Pick the wall into which the roof needs to terminate (see Figure 7.56).
4. Your roof should look like Figure 7.57. Select the three walls below the roof.
5. On the Modify | Walls tab, click the Attach Top/Base button.
6. Select the canopy roof.

Picking the wall is easier said than done, mostly because it’s hard to tell whether you’re picking the correct wall. Simply hover your pointer over the wall until the entire face becomes highlighted. When you see this, pick the wall. The roof will then extend to the wall.
The walls are now joined to the roof, as shown in Figure 7.58.

**Figure 7.56**: Picking the roof and the wall to join the two together

**Figure 7.57**: The completed canopy
All of the conventional roofing systems have been added. Let’s move on and add some dormers. This process will require the use of a collection of the tools with which you’ve gained experience up to this point.

Adding a Roof Dormer

The best way to add a roof dormer is to modify an existing roof. You certainly have plenty of those in this model, so there should be no shortage of roof surfaces you can chop up into dormers.

To begin adding a roof dormer, follow these steps:

1. Go to the Level 3 floor plan.
2. Zoom in on the corridor roof.
3. Select the corridor roof, as shown in Figure 7.59.
4. On the Modify | Roofs tab, click the Edit Footprint button. You’re now in the Sketch Mode for this roof. The procedure to modify the roof is reminiscent of climbing up on an actual roof and adding a dormer.

1. On the Modify | Roofs ➔ Edit Footprint tab, select the Split Element button, as shown in Figure 7.60.

2. On the Options bar, deselect Delete Inner Segment.

3. Pick two points on the roof edge (see Figure 7.60). The two points are an even 4’ (1200 mm) in from each edge.

4. Press Esc twice.

5. Select the middle line.

6. On the Options bar, deselect Defines Slope.
With the length of the dormer established, you need to indicate to Revit that you want it to be a gable-end dormer. You do this by adding slope arrows:

1. On the Draw panel, click the Slope Arrow button.
2. For the first point of the slope arrow, click the endpoint of the first point you split (marked 1 in Figure 7.61).
3. For the second point of the slope arrow, pick the endpoint of the same line (see Figure 7.61).
4. Add a second slope arrow coming from the opposite side of the ridgeline, as shown in Figure 7.62.
5. Press Esc twice.
6. Select both slope arrows.
7. In the Properties dialog box, under Constraints, change Specify to Slope.
8. Under Dimensions, keep the slope at 9" / 12" (750 / 1000 mm) (see Figure 7.63).

9. Click Finish Edit Mode.

10. Go to a 3D view to check out the dormer. It should look identical to Figure 7.64.
Figure 7.63: Changing the values of the slope arrows

Figure 7.64: The completed roof dormer
Adding roof dormers takes some practice to become efficient. If you don’t feel confident that you can add a roof dormer on your own, either go back through the procedure or find another place in the building to add a second dormer.

**NOTE** Notice in the 3D view that the wall followed the modification in the roof. This is because you attached the wall to the roof back when you added the roof to the corridor. The walls have no choice but to comply!

**Are You Experienced?**

**Now you can...**

✓ place different types of roofs, including flat roofs, pitched roofs, and unconventional sloping roofs, using the footprint of your building

✓ analyze tricky areas and make multiple roofs if needed instead of relying on a single roof to flex and conform to the situation at hand

✓ edit wall joins to allow walls to attach to roofs after they’re created

✓ design different roof systems based on their functionality

✓ create a tapered roof plan using a variable material in the roof system

✓ create a roof by extrusion by setting work planes and using them to lay out a custom roof

✓ create a roof dormer by editing an existing roof and adding slope arrows to indicate a gable end